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User’s Manual
Thank you for purchasing our product. 
Carefully read this instruction manual 
before using this unit.
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■ Notices about this User’s Manual
Carefully read this manual so that you can properly use this product.
T&D Corporation accepts no responsibility for any malfunction of and / 
or trouble with this product or with your computer that is caused by the 
improper handling of this product and will deem such trouble or 
malfunction as falling outside the conditions for free repair of the 
attached warranty.
●All rights of this user’s manual belong to T&D Corporation. It is prohibited 

to use, duplicate and / or arrange a part or whole of this user’s manual 
without the permission of T&D Corporation.

● Microsoft  and Windows  are registered trademarks of Microsoft 
Corporation USA and are binding in the USA and all other countries.

● Company names and product names are trademarks or registered 
trademarks of each company.

● Specifications, design and other contents are subject to change 
without notice.

● On screen messages in this manual may vary slightly from the actual 
messages.

● Please notify the shop where you purchased this product or T&D 
Corporation of any mistakes, errors or unclear explanations in this 
manual. T&D Corporation accepts no responsibility for any damage or 
loss of income caused by the use of our product.

● This product has been designed for private or industrial use only. It is 
not for use in situations where strict safety precautions are necessary 
such as in connection with medical equipment, whether directly or 
indirectly.

● We are not responsible for any malfunction or trouble caused by the use 
of our product or by any problem caused by the use of measurement 
results of our unit. Please be fully aware of this before using our product.

● Some of our products, which come under the category of strategic 
goods in foreign trade law, need the permission of the Japanese 
government to be exported outside of Japan.

●This user’s manual cannot be reissued, so please keep it in a safe place.
● Please carefully read warranty and provisions for free repair.
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■ Escape Clauses
● T&D Corporation does not guarantee the operation of T&D Recorder 

for Windows .
● T&D Corporation shall not accept any responsibility for any damage, 

whether direct or indirect, that results from the usage of T&D Recorder 
for Windows.

● Specifications of T&D Recorder for Windows may be subject to 
change and service may be terminated without advance notice to the 
user. In such a case, T&D Corporation shall not be responsible for any 
damages, whether direct or indirect, from the inability to use T&D 
Recorder for Windows.

● T&D Corporation has no obligation to correct any defects found in 
T&D Recorder for Windows.

■ Copyright
● The Copyright for T&D Recorder for Windows, including the program 

and relevant documents, belongs solely to T&D Corporation.
● The reprinting or redistribution for commercial purposes whether in 

part or in whole, in magazines or as a part of any product is strictly 
forbidden without the expressed consent of T&D Corporation. Any 
inquires concerning commercial redistribution should be directed to 
the Sales Department of T&D Corporation.

● Please do not attempt to make any changes or modifications to T&D 
Recorder for Windows.

Software User Agreement
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■ Outline
By using T&D Recorder for Windows, you can easily display the data 
measured and recorded with the RTR-51/52/53, RVR-52 via our 
exclusive short-wave wireless technology in table or graph form and 
control printing with your computer.
Upon opening T&D Recorder for Windows, a launcher window in which 
icons are displayed will appear. By clicking an icon, the graph, settings, 
and /or communication screen for that type of unit will be displayed.
This software requires the following operating environment:
   Compatible OS  Microsoft Windows 98 ／ Me ／ NT 4.0
                              Microsoft Windows 2000 ／ XP
          PC ／ CPU  IBM compatible equipped with more than Pentium 90MHz or 
                              NEC 98 Series with serial communication (RS-232C D-Sub 9 pin).
               Memory  More than16MB memory capacity
            Hard Disk  More than 4MB of empty hard disc space
        Monitor VGA (Above SVGA (800×600) is recommended)
                              More than 256 colors can be displayed

■ Basic Functions
● Group and Remote Unit Registration

If you wish to carry out wireless communication between an RTR-57C unit 
and RTR-51/52/53, RVR-52 unit, it is necessary to first complete via 
computer the remote unit registration of the RTR-51/52/53, RVR-52 unit to 
the RTR-57C. Remote units can be operated and managed in Groups.

● Display of Data List Collected in RTR-57C
A list of all data collected at the time of downloading is displayed, from which 
all or part of the data can be used to create files or graphs.

● Mixed Use with Other Units is Possible
You can make graphs in which data from RTR-51/52/53 and RVR-52 units 
are mixed. If TR-5/TR-7 Series data have been read into the RTR-57C unit, 
management of such mixed data is also possible.

● Temperature and Humidity Graph / Multi-Scale Graph
In temperature and humidity graphs, the graph or list of temperature and 
humidity data is displayed. In multi-scale graphs, the graph or list of voltage, 
pulse, temperature and humidity data is displayed. You can also set the 
scale or units to match the type of downloaded data.

What is T&D Recorder for Windows ？
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Can Display 8 Channels of Data in One Graph
Can simultaneously display up to 8 channels of recorded data downloaded 
from a main unit in one graph.
Printing Graphs and Data Lists
You can print graphs displayed on screen in full color. When printing a data 
list, the printing of every recording date is possible.
Measured Data List Display
In the measured data list display, the maximum, minimum, and average 
values are shown in different colors.

● Event Viewer
In the event viewer, a data list showing the time of events is displayed.
Print Preview and Print
Select the data to be printed and after checking it in the preview window 
you can proceed to print.

● Creating Text File
Recorded data can be saved in universal Text file format (such as CSV 
Format) to be read and manipulated by all common spreadsheet software 
such as Excel or Lotus.
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It is possible to carry out some operations such as recording start settings or 
changes, and downloading recorded data via communication with an RTR-57C 
unit without connecting to a computer. For details, please see the RTR-57C 
User’s Manual.
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■ Optical Communication
By using the communication cable, you can carry out direct communication 
with a computer or with an RTR-57C unit.

Communication with Data Loggers
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Collect

List

１.Using the supplied communication cable, connect the RTR-57C to 
your computer.

２.To carry out communication, place the data logger face down on the 
RTR-57C.

There are two methods to communicate with RTR-51/52/53, RVR-52 
data loggers; they are [Optical Communication] and [Wireless 
Communication].
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Connect to Computer

Place the data logger 
face down.
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１.Register the Remote Unit.
Via the RTR-57C, connect a data logger to your computer and using 
the T&D Recorder for Windows software register that data logger as 
a Remote Unit.

２.Place the Remote Unit in the actual place where you wish to make 
measurements.
If direct and unobstructed, the communication range is about 100 
meters.

■ Wireless Communication
Downloading recorded data from a data logger in the field to an RTR-57C 
unit can be carried out via wireless communication (Special Short-wave 
Radio Data Communication).

● If direct and unobstructed, the communication range is about 
100 meters.

３.Carry out the Wireless Communication Test.
There are instances when communication cannot occur within 100 
meters. Please check to see if communication is possible by 
running a Search for Remote Units that have been registered via 
the RTR-57C.

Collect List

メイン メニュー
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Group

100m



Installing the Software

■ Install the Software  (T&D Recorder for Windows)
１.Start Windows.

２.Place the CD-ROM in the appropriate drive, and the ｢Install Program｣ 
window will automatically open.

●If that window does not open automatically, open the ｢My Computer｣ window 
and double-click on the icon for the CD-ROM.

● Is Windows  working properly?
If Windows is not activated properly, it may be impossible to install and run 
T&D Recorder for Windows.

● Quit all applications.
If you are running other applications, make sure to quit them before 
installation. If you have any permanently active software, such as a virus 
check or scan program in your computer, make sure to also quit it.

5

３.Select [Install T&D Recorder for Windows] and by clicking on the 
[START] button the installation will begin.

４.Confirming the contents as you go, install the software according to 
the directions.

After installation is completed, an icon for [T&D Recorder for Windows] 
will appear in the Start Menu.

[START]
button

[Install T&D Recorder
 for Windows]
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Operating the Software

■ Opening the Software
Open the software by clicking on [T&D Recorder for Windows] from the 
list of programs in the Start Menu.

● Menu Bar
In the Menu Bar are Menus containing an array of commands. Click on the 
desired menu in the menu bar to set or display functions for each type of 
device.
By clicking [Display]-[ Change Icon Layout ] or [Change Icon Size], you can 
select how you wish the Main Window to appear.

● Toolbar
Can choose to view or hide icons. You can also make this setting from the 
Menu Bar by clicking [Start]-[Select Menu].

● Icons
By clicking on an icon, the graph or communication display will appear for 
that type of unit. The graph and communication displays for each type of 
unit can also be viewed by clicking on that unit’s type name in [Start] of the 
Menu Bar.

■ Main Window
Upon opening T&D Recorder for Windows, a launcher window in which 
icons are displayed will appear. By clicking an icon, the graph, settings, 
and / or communication screen for that type of unit will be displayed.

Menu Bar

Icon

Toolbar
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〔Contents〕
By clicking the mark of the classified topic, an explanation will be displayed.

〔Index〕
Select a key word from the key word list and by clicking the [Display] button, 
the explanation will be displayed.

〔Search〕
Enter the key word you wish to search for and click the [Start Search] 
button and the topic in which the key word is included will be displayed. 
Then select the topic and click the [Display] button to have the explanation 
displayed.

● Click on the [Help] button in any dialog box and explanations about the 
dialog box will be displayed.

● In the graph display window, after clicking on the  in the toolbar, you can 
click on any Menu, any Icon, or any part of the Main window and an 
explanation will be displayed.

■See the Help Menu of the software for more detailed 
information about how to use the software.

● To search for unclear words or terms, click the [Help] Menu that appears in 
the Menu Bar and then click on one of the tabs [Contents], [Index] or 
[Search].

Contents Index Search
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■Connect the communication cable to your computer.
Connect the RS-232C communication cable (included in pack) to the 
serial port of your computer.

■ Connect the Data Logger to your Computer.
If the data logger is an RTR-51/52/53, or RVR-52 unit, connect it to your 
computer via an RTR-57C unit.

Serial Port Markings
The communication cable connection is a 
D-Sub 9 pin female. Please connect it to a port 
that has markings such as these.
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Connect the communication cable from 
your computer to the RTR-57C unit.

Place the data logger face 
down on the RTR-57C.

Note: 
● If the cable is connected to the wrong port, communication cannot take place. 
●Be sure to securely connect the cable to avoid any communication failure 

due to a loose connection.

Computer Communication Settings



9

[Auto Detection]

■ Setting Up the Serial Port
Set the serial port to be used for communication with the data logger. 
There are two ways to set up the serial port [Auto Detect] and [Select a 
Port].
● When you wish to use the same COM port to carry out communication 

with different types of units.
Check [Set Common COM Port for All Types] and click the [OK] button to 
complete at once the port setting for all types of units.  

１.In the main window, open the setting, communication display of the 
type of data logger connected to the computer and click the [Serial 
Port Settings] tab.

２.Click the [Auto Detect] button to start the detection process.

３.When the detection is completed, a message will be displayed in the 
[Detection Results] section.

４.By clicking the [OK] button, the setting process will be finished and 
the port to which the data logger is connected will be set.

５.By clicking the [Close] button, the setting will be completed.

[Close]
button[OK] button

[Auto Detect]
 button

When setting up more 
than one type at the 
same time

Detection
Results

[Serial Port Settings] tab
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[Selecting a Port]

１.Click the [Serial Port Settings] tab in the settings / communication 
display of the data logger to be used.

２.From the [Possible COM Ports] list box choose and check the port 
to which the data logger is connected.

３.Click [OK] button to finish set-up and close the dialog box.

４.By clicking the [Close] button, the setting will be completed.

[Serial Port Settings] tab

[OK]
button

[Close]
button

When setting up more 
than one type at the 
same time

Possible COM Ports
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■ Registering a Remote Unit
１.By selecting the icon [Remote Unit Registration], a message will be 

displayed.
※ Remote unit registration can be carried out for each type of unit from the 
setting / communication menu for that unit [Communication]- [Remote Unit 
Registration].

This function allows you to collect all remote unit registration info in 
the RTR-57C.  That info (Group Name / Remote Unit Number / 
Remote Unit Name) will be displayed in a list.  In order to delete, 
change or register any groups or remote units in an RTR-57C, it is 
necessary to connect that RTR-57C to your computer and carry out 
the [Collect Registration Info] before proceeding.

Collect Registration Info

Remote Unit Registration

２.By clicking the [Yes] button, collection of the registration info will begin 
and a list will be displayed.

[Yes] button

《Enlarged Message》

The default setting for the 
registered group name is 
[Group 1].
Remote unit registration 
into [Group 1] is possible.
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● Group Names
Group Names can be entered with up to 8 letters.
You can also select an already registered group name and make slight 
changes to make a new name.

● If the registration info has not been collected or you wish to collect 
again, click [Collect Registration Info] button in the [Registration 
Contents] window to collect the registration info.

[Collect Registration Info] 
button

３.Click the [Register] tab, and set the Group Name, Remote Name, 
and Communication Frequency Channel.

[Register] tab

[Close]
button

[Register]
button

Remote Unit Name

Group Name
Communication
Frequency Channel
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● Remote Names
Remote Names can be entered with up to 8 letters. You can also select 
an already registered remote name and make slight changes to create 
a new name.

● Communication Frequency Channel
By clicking the [Set] check box you can select a channel number.
One Frequency Channel (0-3) can be set for each Group.

● The default frequency channel setting for Group 1 is ‘0’
● If no settings are chosen, an unused frequency channel will be 

automatically assigned.

NOTE:
● A frequency channel setting can only be made when registering a 

new group.
● Once a channel has been set for a group it cannot be changed.
● The specified frequency channel will be used for all communication 

with remote units in that group. If another RTR-57C is using the same 
channel in the same area, communication may become unstable.

４.By clicking the [Register] button, registration will be completed. 
●If you are registering a number of remote units to the same group, place 

each one on top of the RTR-57C and carry out the registration into the 
same group.

● If you are registering units to different group names, please follow  the 
above steps over again.

《Remote Registration Display》
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● By clicking on a Group Name, the Frequency Channel for that group, 
as well as, the Remote Unit Names and Numbers for that group will be 
displayed.

５.Upon completion the [Registration Contents] will be displayed and 
by clicking [Close] the registration will be finished and the window 
closed.

《[Registration Contents] display enlargement》

Frequency Channel

Number of Possible 
Registrations

Remote Number and Name

[Close]
button
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For details, see the RTR-57C User’s Manual.

■ Position the remote unit(s)in the place(s)where 
you want to measure and check if communication 
is possible.

From an RTR-57C unit, it is possible to find any registered Remote Unit 
and make sure communication can be carried out.

１.In the Main Window, activate [Find Remotes].

２.Choose the range in which to search and activate.
● If you choose [All Groups], the search for remotes in all registered groups 

will begin immediately.
● If you choose [Specify Group], select the desired group from the list to 

start the search.

３.After the search has been completed, a list of possible Remote Units 
for communication will appear in a list.
● Remote Units for which communication is possible will be marked with 

an  before its name.
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Other Remote Unit
Registration Functions

The following operations can be carried out in the Remote Registration 
Window.  Be sure to connect the RTR-57C to your computer and collect 
the registration info of RTR-57C before carrying out these operations.

■ ｢File｣Menu: [Save Registration Contents]
You can save the Group and Remote Unit Registration Info to a file.

NOTE:
● You cannot edit the contents of registration info from a saved file.
● You cannot send text file.

1. From the [File] Menu, choose [Save Registration Contents to File].

2. Designate the saving location and enter a file name.

3. Click the [Save] button to save the file.

[Return to Original]
button

[Send] button

[Collect Registration Info] 
button

[File] Menu

[Set Number of Possible Registrations]
button
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■ [File] Menu: [Save as Text File]
You can save the Group and Remote Unit Registration Info as a text file.
NOTE: 
You cannot edit the contents of registration info from a saved file.

1. From the [File] Menu, choose [Save as Text File].

2. Designate the saving location and enter a file name.

3. Click the [Save] button to save the file.

NOTE: 
If changes are made to the pattern, the Remote Unit Registration Contents 
saved in the RTR-57C will be automatically returned to the original default 
contents. Please be careful.

■ [Set Number of Possible Registrations] Button
There are two patterns for setting and registering the largest number of 
groups and remotes into one RTR-57C.
・Pattern 1: <Group Numbers: 60 ／ Remote Numbers in 1 Group: 64>
・Pattern 2: <Group Numbers: 15 ／ Remote Numbers in 1 Group: 250>
The Default Setting is: Pattern 1:  <Group Numbers: 60 / Remote Numbers in 
1 Group: 64>

1. Select a pattern. 

2. Click [OK] button to complete the change.

[OK]
buttonCheck one
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■[Remote Registration Contents] – [Return to Original] 
Button

All info saved in the RTR-57C will be erased and will be returned to as it 
was when it left the factory: Group Name: Group 1 / Remote Unit: NONE 
/ Communication Frequency: 0

1. Connect the RTR-57C unit you wish to return to the factory settings.

2. Click the [Return to Original] button, and the process will begin. 

■ [Remote Registration Contents] – [Send] Button
If the Registration Contents are the same in a number of RTR-57C Units, 
communication is possible between 1 Remote Unit and any number of 
RTR-57C Units. To make the contents the same, it is possible to transmit 
them to a number of RTR-57C Units.

NOTE: 
● By sending, you will delete all prior registration contents.
● If the number of files to be sent is over the number of possible registrations, 

it will be impossible to transmit them. Please see p.17 for details about the 
possible number of registrations.

1. Save the registration contents you wish to send. (See p. 16 for details)

2. Click [Open] from the [Fi le] Menu and open those Remote 
Registration Files you wish to send.

3. The contents of those files wil l be displayed in the Remote 
Registration Contents Window.

4. Click the [Send] button to begin transmission.
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■「Change ／ Delete」
You can make changes to a registered Remote Unit Name or delete a 
Group or Remote Unit.

[Change] Button…Only for Remote Names
1. Select the Group in which the Remote you wish to change is 

registered.

2. Select the Remote Number or Name and enter the new Remote Name 
for the unit.

3. Click the [Change] button to send the new information.

[Delete Group] Button
By deleting a Group, all Remote Units registered to that Group will be 
automatically deleted.
1. Select the Group Name you wish to delete.

2. Click [Delete Group] to begin the process.

[Delete Remote] Button
1. Select the Group Name in which the remote you wish to delete is 

registered, then select the Remote Number(s) or Name(s).

2. Click [Delete Remote Unit] to begin the process.

[Change] button

[Delete Group] button

[Delete Remote Unit]
button
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● RTR-57C Registration Status:
If remotes are registered in the presently connected RTR-57C
: exist

If remotes are not registered in the presently connected RTR-57C
: Not exist

If registration info has not been collected from presently connected RTR-57C
: －

● Wireless Recording Start
If forbidden to start recording: FORBID
If permission to start recording: PERMIT

■「Remote Unit Info」
This allows you to view the registration contents of any Remote Unit 
presently connected to the RTR-57C. The Registration Contents of units 
registered to a different RTR-57C can be viewed as well.

1. Place the Remote Unit from which you wish to collect remote info 
face  down on the RTR-57C.

2. Click the [Collect Remote Unit Contents] button and the info will 
appear for that unit.

[Collect Remote 
Unit Contents]

button
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RTR-51/52: Start Recording

１.In the main display, click the icon [RTR-51/52].

２.Click the [Start Recording] tab and make recording settings.

●Recording Start Date / Time: <Select: Programmed Start / Immediate Start>
Select the Recording Start Method
・Programmed Start: Recording will begin on the day and time entered.
・Immediate Start: Recording will begin as soon as settings are completed. 

● Recording Interval: <Select from: 1,2,5,10,15,20,30 seconds or 1,2,5,10,
 15,20,30,60 minutes>
By clicking ▼ you can select from the recording interval list.

● Recording Mode: <Select from: One-time / Endless>
One-time: When the number of readings has reached 16,000, the unit display
 will read FULL and recording will automatically stop.
  Endless: When the number of readings reaches 16,000, the next one will
 overwrite the oldest or first reading.

● Temperature Unit: <Select from: Celsius [℃ ] or Fahrenheit [。Ｆ] >
Change the display of temperature on the Thermo Recorder between [℃ ] and [。Ｆ] .
※ By clicking the [Get Settings] button, registration contents and remaining 
battery life will be displayed.

３.After making all the desired settings, click the [Start Recording] 
button to transmit them. 

４.After transmission has been completed the communication result 
will appear. By clicking [OK], the set-up process will be finished. By 
clicking [Close], you can close the window.

｢Start Recording｣
tab

[Start Recording]
button

[Close]
button

[Detailed Settings] button
[Stop Recording] button

[Get Settings] button
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■ [Stop Recording] Button
Stop current recording of data logger.

■ [Get Settings] Button
The Remote Unit recording settings, registration contents, and remaining 
battery life are displayed.
● Registration contents: If a settings transmission was received it displays 

the Group and Remote Name(s).
● Remaining battery life: If a settings transmission was received it displays 

the remaining battery life.

■ [Detailed Settings] Button

● Start Wireless Communication:  Restrict the permission to start 
recording by wireless communication.
１.If you wish to forbid the starting of recording by wireless 

communication, check [FORBID]; to allow, check [PERMIT].

２.Click [OK] to complete and close.

● Upper and Lower Limits: To check whether or not the data downloaded 
into the RTR-57C falls within a certain set range.
１.By checking the [Set Limits] box, you will be able to enter an upper 

and lower limit.

２.Click [OK] to complete and close.

By checking, you can make entries.

Check one
[OK]

button
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■ Connect the RTR-51/52 unit for communication 
with your computer.

※ See P.3 or P.8 for about how to connect.

RTR-51/52: Downloading Recorded Data

■ Download Recorded Data.
１.In the main window, click the icon [RTR-51/52].

２.Click the [Download Recorded Data] tab.

３.After selecting the downloading range, click the [Download] button 
to start downloading.

４.When downloading has been completed a graph will be displayed.
If you have checked [After downloading, specify file in which to save 
data] in the Detailed Settings, please view the graph after specifying 
the file in which you wish to save the downloaded data.

[Close]
button

[Download] 
button

Select the
downloading range

[Download Recorded Data] tab

[Detailed Settings] 
button
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■ [Detailed Settings] Button
You can make settings for the processing of the downloaded recorded data.

1. Select the desired processing method.

2. Click [OK] button to complete the setting.

Check one

[OK]
button
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RTR-53: Start Recording

１.In the main window, click the icon [RTR-53].

２.Click the [Start Recording] tab and set the recording conditions.

●Recording Start Date / Time: <Select: Programmed Start / Immediate Start>
Select the Recording Start Method
・Programmed Start: Recording will begin on the day and time entered.
・Immediate Start: Recording will begin as soon as settings are completed. 

● Recording Interval: <Select from: 1,2,5,10,15,20,30 seconds or 1,2,5,10,
 15,20,30,60 minutes>
By clicking ▼ you can select from the recording interval list.

● Recording Mode: <Select from: One-time / Endless>
One-time: When the number of readings has reached 8000, the unit display
 will read FULL and recording will automatically stop.
  Endless: When the number of readings reaches 8000, the next one will
 overwrite the oldest or first reading.

● Temperature Unit: <Select from: Celsius [℃ ] or Fahrenheit [。Ｆ] >
Change the display of temperature on the Thermo Recorder between [℃ ] and [。Ｆ] .
※ By clicking the [Get Settings] button, registration contents and remaining 
battery life will be displayed.

３.After making all the desired settings, click the [Start Recording] 
button to transmit them. 

｢Start Recording｣
tab

[Start Recording]
button

[Close]
button

[Detailed Settings] button
[Stop Recording] button

[Get Settings] button

[Main Unit Display Settings] button
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４.After transmission has been completed the communication result 
will appear. By clicking [OK], the set-up process will be finished. By 
clicking [Close], you can close the window.

■ [Get Settings] Button
The Remote Unit recording settings, registration contents, and remaining 
battery life are displayed.
● Registration contents: If a settings transmission was received it displays 

the Group and Remote Name(s).
● Remaining battery life: If a settings transmission was received it displays 

the remaining battery life.

■ [Main Unit Display Settings] Button
Set the desired unit of measurement display for the RTR-53 unit LCD display.
１.Select the unit of display you wish to set.

２.Click the [Send] button to complete the setting.

Check one

[SEND]
button
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■ [Stop Recording] Button
Stop current recording of data logger.

● Start Wireless Communication:  Restrict the permission to start 
recording by wireless communication.
１.If you wish to forbid the starting of recording by wireless 

communication, check [FORBID]; to allow, check [PERMIT].

２.Click [OK] to complete and close.

● Upper and Lower Limits: To check whether or not the data downloaded 
into the RTR-57C falls within a certain set range.
１.By checking the [Set Limits] box, you will be able to enter an upper 

and lower limit.

２.Click [OK] to complete and close.

■ [Detailed Settings] Button

Check one

By checking, you can make entries.

[OK]
button
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■Connect the RTR-53 unit for communication with 
your computer.

※ See P.3 or P.8 for about how to connect.

■ Download Recorded Data.
１.In the main window, click the icon [RTR-53].

２.Click the [Download Recorded Data] tab.

３.After selecting the downloading range, click the [Download] button 
to start downloading.

４.When downloading has been completed a graph will be displayed.
If you have checked [After downloading, specify file in which to save 
data] in the Detailed Settings, please view the graph after specifying 
the file in which you wish to save the downloaded data.

■ [Detailed Settings] Button
You can make settings for the processing 
of the downloaded recorded data.

1. Select the desired processing method.

2. Click [OK] button to complete the setting.

[OK]
buttonCheck one

RTR-53: Downloading Recorded Data

[Close]
button

[Download] 
button

Select the
downloading range

[Download Recorded
Data] tab

[Detailed Settings] 
button
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RVR-52: Start Recording

１.In the main display, click the icon [RVR-52].

２.Click the [Start Recording] tab and make recording settings.

●Recording Start Date / Time: <Select: Programmed Start / Immediate Start>
Select the Recording Start Method
・Programmed Start: Recording will begin on the day and time entered.
・Immediate Start: Recording will begin as soon as settings are completed. 

● Recording Interval: <Select from: 1,2,5,10,15,20,30 seconds or 1,2,5,10,
 15,20,30,60 minutes>
By clicking ▼ you can select from the recording interval list.
※ In event recording, the interval is always 1 second.

● Recording Mode: <Select from: One-time / Endless>
One-time: When the number of readings has reached 16,000, the unit display
 will read FULL and recording will automatically stop.
  Endless: When the number of readings reaches 16,000, the next one will
 overwrite the oldest or first reading.
※ In event recording, the number of readings is 8,000.

● Measurement Mode: <Select: Voltage / Pulse>
 Voltage/Instantaneous Value: Record the vol tage measurement as the 
  ins tantaneous va lue for  each record ing 
  interval span.

｢Start Recording｣
tab [Get Settings] button

[Stop Recording] button

[Detailed Settings] button

[Close]
button

[Start Recording]
button
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３.After making all the desired settings, click the [Start Recording] 
button to transmit them. 

４.After transmission has been completed the communication result 
will appear. By clicking [OK], the set-up process will be finished. By 
clicking [Close], you can close the window.

■ [Get Settings] Button
The Remote Unit recording settings, registration contents, and remaining 
battery life are displayed.
● Registration contents: If a settings transmission was received it displays 

the Group and Remote Name(s).
● Remaining battery life: If a settings transmission was received it displays 

the remaining battery life.

 Voltage/Average Value: Record as the average value for each recording
  interval span. The average value for recording 
  intervals under 15 seconds will be calculated as 
  the average of the measurements from every 1 
  second. The average for intervals over 20 
  seconds will be calculated as the average of 
  the measurements from every 2 seconds.

 Pulse/ Lo→Hi: Record the number of signals rising within the
  recording interval you have set.
 Pulse/ Hi→Lo: Record the number of signals falling within the
  recording interval you have set.
 Pulse/ Event: Record the time of any event; a rising (Lo to Hi)
  or falling (Hi to Lo) waveform that occurs for
  more than 1 second at an input voltage range of
  between 0-30V. 

※ By clicking the [Get Settings] button, registration contents and remaining 
battery life will be displayed.
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■ [Stop Recording] Button
Stop current recording of data logger.

■ [Detailed Settings] Button

● Start Wireless Communication: Restrict the permission to start 
recording by wireless communication.
１.If you wish to forbid the starting of recording by wireless 

communication, check [FORBID]; to allow, check [PERMIT].

２.Click [OK] to complete and close.

● Upper and Lower Limits: To check whether or not the data downloaded 
into the RTR-57C falls within a certain set range.
１.By checking the [Set Limits] box, you will be able to enter an upper 

and lower limit.

２.Click [OK] to complete and close.

By checking, you can make entries.

Check one
[OK]

button



32

■Connect the RVR-52 unit for communication with 
your computer.

※ See P.3 or P.8 for about how to connect.

■ Download Recorded Data.
１.In the main window, click the icon [RVR-52].

２.Click the [Download Recorded Data] tab.

３.After selecting the downloading range, click the [Download] button 
to start downloading.

４.When downloading has been completed, a Graph or Event Viewer 
will be displayed.
If you have checked [After downloading, specify file in which to save 
data] in the Detailed Settings, please view the graph or Event Viewer 
after specifying the file in which you wish to save the downloaded data.

■ [Detailed Settings] Button
You can make settings for the processing 
of the downloaded recorded data.

1. Select the desired processing method.

2. Click [OK] button to complete the setting.

RVR-52: Downloading Recorded Data

[OK]
buttonCheck one

[Close]
button

[Download] 
button

Select the
downloading range

[Download Recorded
Data] tab

[Detailed Settings] 
button
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RTR-57C: Downloading Recorded Data

■ Connect RTR-57C to your computer to carry out 
communication.

※ For details about how to connect, see the user’s manual for RTR-57C.

■ Collect RTR-57C Data Info.
１.In the main window, click the icon [RTR-57C].

２.Click the [Download Recorded Data] tab.

[Download Recorded Data] tab

[Collect Data Info]
button

３.By clicking the [Collect Data Info] button, communication will be started 
and the data list saved in RTR-57C will be displayed.

Data List

[Quit Collecting
Data Info] button
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【Quit collecting data info while in progress】
By clicking [Quit Collecting Data Info], the collection will be stopped.

②

①

① Collection of data info has been completed. All operations are possible.
② Data downloading and deletion can be done, but data info cannot be 

displayed.

■ Download Recorded Data.
１.Select the data to be downloaded from the data list.

※ To download several sets of data at one time, see p.36-37 for details.

Select data
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●By clicking the [Cancel Downloading] button, you can stop downloading 
at any time.

２.By clicking the [Download] button, downloading will be started.

[Cancel Downloading]
button

３.When downloading has been completed, the graph will be 
displayed.
※ If you have checked [After downloading, specify file in which to save 
data] in the Detailed Settings, please view the graph after specifying the 
file in which you wish to save the downloaded data.

■ [Detailed Settings] Button
You can make settings for the processing of the downloaded recorded data.

１.Select the desired processing method.

２.Click [OK] button to complete the setting.

[OK]
buttonCheck one
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■ Downloading Several Sets of Data at One Time
You can make settings for the processing of the downloaded recorded data.

１.While holding down the [Shift] key or [Ctrl] key, click on those sets of 
data you wish to download.

(For Example)
● If you wish to download files not in a row, such as No.1 and No.3, hold 

down the [Ctrl] key and click on files for No.1 and No.3.
● If you wish to download files in a row, such as No.1, No.2 and No.3, 

hold down the [Shift] key and click on the files for No.1 to No.3.

２.Click on the [Download] button, and downloading will be started.

３.When downloading has been completed, a graph will be displayed.
※ If you have checked [After downloading, specify file in which to save data] 
in the Detailed Settings, please view the graph after specifying the file in 
which you wish to save the downloaded data.

[Cancel Downloading]
button

Use the [Shift]
key to select

Use the [Ctrl]
key to select
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● If you have checked [After downloading, specify file in which to save 
data] and you have selected several sets of data, at the end of the 
specified file name of every recorded data will appear the list number 
(No.1→001, No.2→002,No.3→003…)

● If you have checked [After downloading, automatically show graph] 
and have selected several sets of data, it is possible to  display the 
selected data in the same graph. Moreover, in the graph display by 
entering which file you wish the data to be saved, it is possible to save 
several sets of data into one file.
※ Each kind of data is displayed in the following graphs:

Temperature/Humidity data: Temperature/Humidity Graph
Voltage/Pulse data: Multi-scale Graph
Event data: Event Viewer

File Name List Number

Extension Code
 trx : Universal Thermo Recorder type file
 vtc : Voltage Recorder type file
 pv5 : RVR-52 voltage, pulse data file
 rp7 : RVR-52 event data file
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① [Data Info Display] Button
Displays info about data for all selected data from the list.

【Other Button Functions】

② [Delete Data] Button
Deletes selected data saved in the RTR-57C from the software.

③ [Delete All Data] Button
Deletes all data saved in the RTR-57C from the software.

④ [Select All] Button
Selects all data in list to be downloaded at the same time. 

①

② ③ ④
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３.Select setting method and by clicking the [Set Clock] button, the 
setting will be transmitted.

４.Click [Close] button to complete the setting.

● Set specified time
 If checked: The date/time you enter will be set as the date/time in the 
  RTR-57C.
 If not checked: The current date/time of your computer will be set as the 
  date/time in the RTR-57C.

[Set Clock]
button

[Close]
button

[Set Clock] tab

Setting the RTR-57C Clock

Set the RTR-57C clock from your computer.
１.In the main window, click the icon [RTR-57C].

２.Click the [Set Clock] tab


